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Tables of Standards

Photographs

Preservation Master

Adobe RGB

(48-bit)

600 dpi

Uncompressed TIF

Original Size or minimum 3000
pixels along long dimension
No post-color correction or
touching up/repair

Crop only to photo paper edge

CONTENTdm Version

Adobe RGB

(48-bit)

300 dpi

JPEG

3000 pixels along long dimension
No post-color correction or
touching up/repair

Crop only to photo paper edge

Access/Web Version

sRGB

(48-bit)

72 dpi

JPEG

2000 pixels along long
dimension

Color correction or touching
up/repair is allowed in certain
circumstances

Photographs: 35 mm Negatives, Slides, and Contact Sheets

Preservation Master

Adobe RGB

(48-bit)

2100 dpi

UncompressedTIF

Original Size or minimum 3000
pixels along long dimension
Only prescribed correction or
touching up/repair is allowed (see
guidelines for more detail)
Crop until there is a thin border
outside theimage

CONTENTdm Version

Adobe RGB

(48-bit)

300 dpi

JPEG

3000 pixels along long dimension
No post-color correction or
touching up/repair

Crop until there is a thin border
outside theimage

Access/Web Version

sRGB

(48-bit)

72 dpi

JPEG

2000 pixels alonglong
dimension

Color correction or touching
up/repairis allowed in certain
circumstances

Audio

Preservation Master

CONTENTdm Version

Access/Web Version

Samplerate is 96,000 (Hz)
Uncompressed WAV
Originalsize

No correction or touching
up/repair

Sample rate is between 44,100 -
48,000 (Hz) MP3

Correction or touching up/repair is
allowable in certain circumstances

Sample rate is between 44,100 -
48,000 (Hz) MP3

Correction or touching up/repair
is allowed in certain
circumstances




Maps, Plans, and Oversized

| Preservation Master CONTENTdm Version Access/Web Version
Adobe RGB Adobe RGB sRGB
(48-bit) (48-bit) (48-bit)
600 dpi for size up to 11x17; 300 dpi for size up to 11x17; 72 dpi
570 dpiabove 11x17 200 dpi above 11x17 JPEG
UncompressedTIF JPEG . . 2000 pixels along long dimension
8000 pixels along long 3000 along long dimension . .
dimension No post-color correction or Color co'rrfect|on or t9uch|ng
No post-color correction or touching up/repair up/repairis allowed in certain
touching up/repair circumstances
Crop only to paper edge

Graphic Materials (line drawings, lithographs, watercolors)

Preservation Master CONTENTdm Version Access/Web Version

Adobe RGB Adobe RGB sRGB

(48-Dbit) (48-bit) (48-bit)

600 dpi for size up to 11x17;570 | 300 dpi for size up to 11x17; 72 dpi

dpiabove 11x17 200 dpiabove 11x17 JPEG

UncompressedTIF JPEG . . .
Original Size or 8000 pixels Materials up to 11x17 are 3000 2000 plxelsa!onglong dlmen5|on
along long dimension pixels along long dimension; Color correction or touching
No post-color correction or materials largerthan 11x17 are up/repairis allowed in certain
touching up/repair original size circumstances

Crop only to paper edge No post-color correction or

touching up/repair
Crop only to photo paper edge




Documents

Preservation Master

CONTENTdm Version

Access/Web Version

Adobe RGB
(48-bit)

600 dpi
UncompressedTIF
Original size

repair

Adobe RGB
(48-bit)

300 dpi
JPEG
Original size

No color correction, touching up, or| No post-color correction or

touching up/repair
OCRis allowed

sRGB

(48-bit)

72 dpi

JPEG

Original size

Correction or touching up/repair
is allowed in certain
circumstances

OCRisallowed

Videos

Preservation Master

CONTENTdm Version

Access/Web Version

AVI

525i/59.94 fps-analog NTSC
Or

Original resolution if source
material is digital progressive
scan (i.e. 720x480p,
1280x720p, or 1920x1080p)
PCM (stereo) or AC3

mp4

Original aspect ratio of preservation
master

2 channel 48 kHz AAC or AC3

mp4
minimum 2 channel 44kHz AAC or
AC3




Setting Up a Folder Directory

The first step in digitization is to set up a logical, hierarchical folder directory where the digitized
files will go. For most digitization projects at the CAHC, use the following directory structure:

v [ This PC
On the Desktop, create a folder named J 3D Objects
the collection number (e.g. MS.301). v [ Desktop

Within that folder create a folder called
Access, another called CONTENTdm, a
third called Preservation and a fourth

called Documentation. Adobe Premiere Pro Preview Files

W Collection®

trp.drivedownload

Administrative

Access
COMTEMNTdm
Documentation

Preservation

For the duration of digitization, the files will live here. Once digitization is complete, the entire
directory will be moved to the cahc_stage server and then deleted from the computer desktop.



Digitizing Photographs and Documents

Any special needs of the collection found during the selection process (e.g., whether special
equipment is necessary for digitization or accession numbers need to be assigned), should be
addressed before beginning the scanning process. For scanning in- house, CAHC uses the
Epson Expression 10000XL- Photo Scanner and 11000XL- Photo Scanner.

Naming — Photos and Documents

The file name will reflect the finding aid’s numbering system. How the file name will be
constructed depends upon whether photographs are grouped together in a collection or are
dispersed throughout a collection. The following is a guide to the terminology used in savingfiles:

Definitions

e ualr: Every file name will have ualr at the beginning to emphasize it belongs to UALR
CAHC.

ms: ms is the abbreviation for manuscripts. If the photograph belongs to a manuscript
collection, then use ms before the collection number.

ph: If the photograph belongs to a photograph collection (and not a manuscript
collection), then use ph before the collection number.

Record group/series/subseries numbers: A manuscript or photograph collection
may be divided into record group, series, or subseries. If this is the case, then include
these numbers number in the file name.

¢ Image number: Use pho before the number. The number will be the same as the
identification number given to the original photograph.

Version: Designate the image version using one of the following abbreviations: pm =
preservation master, dm = CONTENTdm version, aw = access/web version, and ot =
other

¢ File type: File names should end according to its format (e.g., “tif")

Additional Notes:

e Use lower-case letters when naming files.

e Use underscores or dashes to represent spaces (e.g., ualr-0001_07 instead of
ualr.0001.07).

e Usenaifafield in the file name does not apply



Naming templates

To name photographs that are grouped together in a series or subseries and individually
numbered, use the following template:

RG# or Series#_ Series or Subseries# Pho#_

To name photographs that are dispersed throughout a collection, use the following template:

ualr- msorph#_  RG#or Series or Box#_  Folder#_ Pho#_

Series#_ Subseries#_

Naming photographs grouped together and individually identified

For a preservation master copy belonging to the Van Buren Scenes photograph collection,
photograph number 1, this template illustrates how the file name would be derived:

ms or ph#_ RG# or Series#_ Series or Subseries#_ Pho#_

ualr- ph-0001_ na_ na_ pho0001_ [pm. tif
ualr-ph-0001_na_na_pho0001_pm.tif

Naming photographs dispersed throughout a collection

For a photograph from the John Barker papers, series 1, box 2, folder 6, the file name would be
derived using this format:

ualr- msorph#_  RG#or Series or Box#_  Folder#_  Pho#_

Series#_ Subseries#_

ualr- ms-0050_ 01_ na_ 02_ 06_ pho01_ pm. tif

ualr-ms-0050_01_na_02_06_pho01_pm.tif



Scanning the Preservation Master — Photos and Documents

The preservation master is the highest-quality digital surrogate of the physical photograph.
Because it should accurately represent the original photograph, this digital copy should not
be altered for aesthetic reasons.

1. Turn on the Epson scanner

2. Open SilverFast Ai IT8, the software that will be used for scanning, by clicking Start on the
program’s welcome screen.

Image Source |EPSON Expression 11000XL USB |
Language selection | US/English 2

2 gl
Start

For Photographic Prints and Documents
1. Place the photograph face-down on the scanning bed in the upper left-hand corner

2, Adjust the following settinggs based on the Photographic Prints Table of Standards described
in the previous section of this manual.

9 SilverFast® /|

WorkflowPilot

OE A E

Reflective Positive 43 Bit Frame
' [ Scan dimensions =
Name [PhotoPrint_002 | I/ ¢ [ opt. Note: Photographs and
Path rs\feacher!Desktop\Digtorkfion | 22| L1PTC negatives should only be
emat [ custom s8] handled by their edges. To
Preset | Typesetter (600 ppi) slen | it avoid touching their surface,
wear cotton gloves.
Res, @ -l B 500ppi 33.5MB
. Expert settings __~
Input Zoom Output
widh (1950 s | @ M (1% | -
Height (3000 |lss | ¢ Mm [z | P
l=J )% Q9
| b £} Densitometer

10



3. Atthetop, select Reflective and 48 Bit.

7'

9 SilverFast" ;']

WorkflowPilot 1

Mo —T
M ﬁ
'j H—H it L&
Reflective Positive 48 Bit Frame History
48 —24Bit
& 16 =8Bt

& 16— 16t
Path rs\teacher\DesktopDigiWorkfic &

Format [ Custom
AT HDR RAW

Preset | Typesetter (500 ppi) -
‘.,‘L 16 Bit HDR RAW

MName PhotoPrint 003

=
Rot/Fip

Res, e 500ppi 33.5MB |

its paper edges. If there are no paper edges, then leave a small
amount of white space around the image.

4. Next to Name, select TIFF for image format and set the
resolution to 600ppi.

5. Click Preview at the top of
the screen. In the preview
window, click and drag the
cursor so that the red
bounding box covers the
entire photograph, including

At this time, take a moment to check the output dimensions under

Expert Settings. If the dimensions (which reflect the red bounding box) are less than 3000
pixels on the longest side, change the longest side to 3000 pixels. If the longest side is longer
than 3000, do not make any changes.

Click Scan.

. Expert settings __~
Input  Zoom Output If your photo needs to be cropped
width (1950 | 32 11 19m0 or deskewed and you're unable to
e [ - J% s (000 pixel ¥ doitin the preview window, adjust
it post-scan in Photoshop after it is
@J i 14 @J saved. See instructions under the
) Cropping and Deskewing section.

For B&W and Color Negative Film

11

1.
2.

Place negatives in film holder shiny side face-down.

Place the film holder on the scanning bed, with the document cover removed and the
transparency guide placed at the back edge of the scanning bed.

Transparency Megative 43 Bit Frame

% [ Scan dimensions =
Mame |FilmMNegd1 TIFF = Opt.
Path rs\teacher'\Desktop\DigWorkflow - IPTC

Format | Custom BN []

Preset | Custom {2100ppi) ¥ |12100 ppi *
Res. e 1600ppi 50.9 MB
- Expert settings __~

Input Zoom Qutput
1
Width 3000 61 r|‘_. 3000 el 2
pixel =
Height 2965 61 1 r|‘_. 2965

=) CHCACIRE

 » £} Densitometer

 » [id] Navigator

P = Picture settings

. Atthetop, select Transparency, Negative, and 48 Bit.



4. Next, select TIFF for the file format and set the resolution to 2100 ppi.

5. Click Preview at the top of the screen. In the preview window, click and drag the cursor so
that the red bounding box covers the entire negative, including a thin outer edge.

6. At this time, take a moment to check the output dimensions under Expert Settings. If the
dimensions (which reflect the red bounding box) are less than 3000 pixels on the longest
side, change the longest side to 3000 pixels. If the longest side is longer than 3000, do not

make any changes.
|_

=

Vendor |Other =

. Expert settings __- Fimtype |Other =

Input Zoom Output ISO/ASA | <Standard: |

4 v ccr
width (1950 |[ss | & I (@50 | ,

. - '1! el * Exposure a ) 0.0 |
Height [3000 | |89 [ 1 [3000 | e - R
m) @ % Qo & =@)g)

7. To make additional adjustments, try changing the settings under NegaFix.

8. C(lick Scan.

For Positive Film (Slides)

1. Place slides in the slide holder shiny side face-down.

2. Place the slide holder on the scanning bed, with the document cover removed and the
transparency guide placed at the back edge of the scanning bed.

3. Atthetop, select Transparency, Positive, and 48 Bit.

9 SilverFast’; |
WorkflowPilot
&, o [ | I
= A [x
43 Bit

Transparency Positive Frame

Mame FilmPos0i TIFF % Opt.
Path rs\teacher\Desktop\DigWorkflow || IFTC
Format | Custom IR [ ]
Preset | Custom (2100ppi) /(2100 | ppi ¥
Res. o 1600ppi 50.9 MB
. Expert settings -
Input Zoom Qutput
o GG ' Em
Width 3000 |61 | | 3000 |

e — pixel ¥
Height |2965 | |61 | 1 q! |2965 |

=] @] % Q)| o
| b €}Densitometer 3
_
_

12



4.
5.

Next, select TIFF for the file format and set the resolution to 2100 ppi.

Click Preview at the top of the screen. In the preview window, click and drag the cursor so
that the red bounding box covers the entire slide, including a thin outer edge.

6. At this time, take a moment to check the output dimensions under Expert Settings. If the

dimensions (which reflect the red bounding box) are less than 3000 pixels on the longest side,
change the longest side to 3000 pixels. If the longest side is longer than 3000, do not make any
changes.

~.__ Expert settings __~
Input Zoom Output
1
Width 1950 39 rTl]. 1950 —
pixel =
Height |3000 89 H “la (3000
l=] ()% Q) 9

7. Click Scan.

Saving the Preservation Master - Photos and Documents

Save the preservation master .tif files in the Collection # > Preservation folder on the desktop.

13

Note: When putting in numbers for boxes, folders, and
documents, add preceding 0s based on the total number of
boxes in a record group/series, folders in a box, and
photographs in a folder (e.g., box 020 for a collection with
over a hundred boxes versus box 20 for a collection with 25
boxes total).



Cropping and Deskewing

The only allowable changes to the preservation master include cropping and skewing. If you
need to do either, open Adobe Photoshop.

To crop:
1. Select the Cropping tool in the left-hand side bar:

File Edit Image Layer Type Select Filter 3D View Window Help

h. - Unconstrained 3 3 -1 Straighten  View: Rule of

2. Using your cursor, select the area of the image you would like to retain. Be sure to
include a thin border of blank space around the image.

3. Go tolmage in the top menu bar, then select Crop.
4. Save your changes to the cropped image.
To skew:

2. Go toImage in the top bar and select Image Rotation, then select Arbitrary.

14



Image Layer Type Select Filter

Mode 4
Adjustments >

Auto Tone Shift+Ctrl+L
Auto Contrast Alt+Shift+Ctrl+ L
Auto Coler Shift+Ctrl+B

Image Size... Alt+Ctrl+]

Canvas Size... Alt+Ctrl+C

Image Rotation 4 180"
Crap 90° CW
Trim... 90° CCW
Reveal All

Duplicate... Flip Canvas Horizontal
Apply Image... Flip Canvas Vertical
Calculations...

Variables 3
Apply Data Set...

Trap...

Analysis 3

3. In Arbitrary, input the number of degrees by which you would like to adjust the image
and select whether it should be skewed clockwise or counterclockwise. For slightly crooked
images, a degree of 1 will often straighten it.

-,

Rotate Canvas @

OR -Eq
© =ccw

4. Click OK. You may need to experiment with different degrees. Undo undesired changes
by going to Edit and Undo.

Angle:

5. Oncefinished, Save your changes.



Creating the CONTENTdm Version — Photos and Documents

Using Photoshop

1. From the Preservation Master, create the CONTENTdm version, which will be uploaded to
CONTENTdm. Open the preservation master in Photoshop and change the specifications to the

following:

Image Size

Pixel Dimensions: 20.2M (was 105.8M)

width:[2357 | | pxes |
IE
Height:[3000 | [Pxes |
Document Size:
width:[7.856 | | Inches
Height: | 10 | | Inches
Resolution: | 300 | | Pixels/Inch

[J5cale Styles
[+] Constrain Proportions
[/] Resample Image:

| Bicubic Sharper (best for reduction)

™ |

2. InImage, under Image Size, change the Resolution to 300 dpi

3. Under Pixel Dimensions, change the long side (the largest number in width or height) to 3000

pixels

4, Atthe bottom of the window, select “Bicubic Sharper (best for reduction)” from the dropdown

menu. Click OK
. Click Save As under the File menu

Append the letters “dm” to the file name

. Click Save

. Drag the slider until the quality says “Maximum” in the JPEG Options dialog box

5
6
7. Under Format, choose JPEG
8
9
1

0.Click OK

JPEG Options

None
Image Options

auy:

small file large file
™

Format Options
(®) Baseline ("Standard™)
(") Baseline Optimized
() Progressive

-
ful

*
Cancel

Preview

44.5M

16



Using IrfanView for Batch Conversions
1. For batch conversions, open the IrfanView software and go to File > Batch

.
Conversion/Rename.
* Batch conversion
Work as:
() Batch conversion Look in | Preservation Masters ~ ‘ (< M s
~
© Batch rename % MName Date Type Size Tags
Batch ion - R it fil
e ) B 221617604 3/20/2019 11:12 AM TIF File 12,875 KB
Batch conversion settings Quick sccess BB HomepageSlide.tif 2/15/2019 315 PM TIF File 1,829 KB
Output format: - B 04-001_0001_covertif TA0/2019 1211 PM TIF File 108,397 KB
JPG - JPG/AIPEG Fomat «|| Options [ UALR Maps 5-028.tiF 8/29/2019 8:59 AM TIF File 16,249 KB
Desktop A ualr-CAHC-5930-C22-...  8/28/2019 1:19 PM TIF File 45,079 KB
CralimEamnei i md) | e B ualr-ph-0018 na_na_p.. 8/29/2019 10:23 AM TIF File 18,765 KB
Batch rename settings i .
Name pattem: Libraries
SN_dm w Options La
This PC
Net\;vurk
File name ~
Files of type: Common Graphic Files >
Qutput folder for result files: for placeholders, like: $D) Sort files Add Remove Term Load TXT
C:'-Users'-.emtanner.UALH'-.Desktop'-Bcamp\e'-.CONTENTdm"
Input files: (6 } Add &l Remove all Move down Save as TXT

Use cument (Look in’) folder Browse

AUsershemtanner. UALR\Desktop\Example
AUserstemtanner. UALR\Desktop\Example
“Usershemtanner. UALRN\Desktop\Example
“Usershemtanner UALRN\Desktop\Example
“Userstemtanner UALRN\Desktop'\Example
AUsershemtanner. UALRN\Desktop'\Example

[ Include subfolders for "Add al" button: not remembered)
Show Preview image

\Preservation Masters'8a16176u tif

\Preservation Masters\Homepage Slide tf

\Preservation Masters\OA-001_0001_covertif
\Preservation Masters\UALR Maps S-028 tif

\Preservation Masters‘\ual-CAHC-5930-C22-C2_006 tif
‘Preservation Masters‘ualr-ph-0018_na_na_pho0060_pm tif

Start Batch
Run test rename

Preview image

Cancel

<

2. In the Batch conversion window, under Work as: select Batch conversion - Rename result
files.

3. Under Batch conversion settings Output format select JPG - JPG/JPEG Format from the
dropdown menu.

4. Next to the dropdown menu click Options. In the Options dialog box, move the Save quality
slider all the way to the right under good and click OK.

JPEG/GIF save options n
JPEG:
low 100 good
Save qualty: <€ >
[]5ave as progressive JPG

[ 5ave as grayscale JPG (please remember!)

[] Disable chroma color subsampling (use 1x1 blocks)
Keep original EXIF data (f JPG to JPG)

Keep original IPTC data

Keep original JPGLComment

Keep original XMP data

[ Try to save with original JPG quality (estimation)
Reset EXIF orientation tag

[ Set file size: [150.00 | kB (Kilobyte)

GIF:

[ 5ave intedaced

[] 5ave with a transparert color
Use main window color for transparency
Choose transparent color during saving
Set transparency value to palette entry: 0

Profiles:

Load Delete Save
Cancel

5. Select the checkbox next to U;;—Advanced Options (fo“r“ioulk resize...) and then click
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Advanced.

6. Inthe Advanced dialog box, match the settings to the image below and click OK.

Set for all images: X
CJcrop: [[]CHANGE COLOR DEFTH:
s ||L ez |1 {can be 16,7 Milion colers (24 BPP) (] shamen: D @ =5
Width: Height: negative) 256 Colors (8 BPP) [ Brightriess: [ ]e25-255)
smi ©Leftop Right top 16 Colors (4 BPP) O contrast: [ ]te7r-12n
comer: Center | Get cument sel. 2 Colors (black /white) (1 BPF) [ Gamma comection: (0.01 - 6.99)
Left bottom Right bottom Custom colors: |0 (2 - 256) [ Saturation (-255 - 255)
RESIZE: Use Floyd-Steinberg dithering [ Color balance - R: l:l (-255 - 255)
@) Set new size: - Use best colar qualtty (slower for large images) [ Colorbalance - G: l:l (-255 - 258)
() Set one or both sides to:
Width: Height: [ Auto-adiust colors [ Color balance - B: (-255 - 255)
(@) pixels [ Herizental flip [ Blur fiter: (1-359)
(®) Set long side to: Crem [ Veertical fiip [] Median filter: l:l 3-9
(O Set short side to: Orinches [ Rotate left [[] Fine rotation: l:l (-360.0 - 360.0)
(O Set image size to: MegaPixel | Rotate right MISCELLANEOUS:
{C) Set new size as percentage of original: [ Convert to grayscale ] Overwite existing files
Width:  0.00 %, Height: % [ Negative [] Delete original files after conversion
Preserve aspect ratio (proportional) [ Auto-crop borders [ Create subfolders in destination folder
Ise: Resample function (better quality) [ Canvas size Settings [ Save files with original date Aime
[] This is the mirimal size (f both sides set) [[] Add ovenay text Settings Apply changes to all pages (TIF/PDF saving)
[] Resize based only on new//old DP| value [] Add watemmark image Settings []Custom processing order | Ehangs arder
Dont enlarge smaller images Replace color it
] Den't shrink bigger images E}B tz: - L 2 e FINECEIIE
Set new DPI value: [JRea [JeGR [1BRG []GRE [JGBR Cancel

7. Under Batch rename settings, the name pattern should be SN_dm.
Batch rename settings:

Mame pattem:

R | Qptions

8. Next, locate and open the folder containing the preservation master files to be converted to
JPEG. Click the Add all button to add the files to the Input files queue.

Fllie name:

Files of type:

Add

Add all

9. Under Output folder for result files, Browse to the CONTENTdm folder to save the JPEG files.
10.Finally, click Start Batch.

Saving the CONTENTdm Version - Photos and Documents

DO NOT SAVE OVER THE PRESERVATION MASTER

1. See the instructions above on naming the file (the name will only differ from the preservation
master by using “dm” instead of “pm” for version and “tif” instead of “jpg” for file type).

2. After you have named it, save it in the CONTENTdm folder.
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Creating and Saving Access/Web Versions — Photos and Docs

On occasion, CAHC will create access/web copies of photographs, which are formatted with loading

speed in mind.

1. To create an access version of a single image, it's easiest to open the image in Photoshop and go

to File > Save for Web.

2. Match the settings in the following image. Click Save.

Save for Web (100%)

Original | Optimized | 2-Up |4

Y RN

Preset: | [Unnamed] v =

PEG v/
[ Maximum | quaity:[100 [~
[erogressive Blur: |0 [~
[ optimized atte:|  |v]

Embed Color Profile

[ Convert to sRGB

Preview: | Monitor Color ]

Metadata: | Copyright and Contact Info v ‘

Color Table

<
I

0 o a a #

Image Size
Wl g (S s
#1901 Jpx =1 ° Qualty: |Bicubic Sharper
Animation

Looping Options: | Once

D@ w0 ]
| Preview... @ E]

. [ 1ot IS

Cancel Done

3. To batch create access copies, open the IrfanView software and go to File > Batch

.
Conversion/Rename.
m Batch conversion
Work as:
B Look ' | | | Preservation Masters v @2 Er
OpBatch rename. Mame Date Type Size Tags
e ) i B 8215176u.F 3/20/2019 11:12 AM TIF File 12,875 KB
Batch conversion settings jQuikckiaccess HomepageSlidedtif 8/15/2018 3:15 PM TIF File 1,820 KB
Qutput format - OA-001_0001 _covertif  7/10/201912:11 PM TIF File 108,397 KB
| PG - JPG/JPEG Format ~| [ options | UALR Maps S-0284f  8/20/2019 8:50 AM TIF File 16,249 KB
Desktop i ualr-CAHC-5030-C22-...  8/28/2019 1:19 PM TIF File 45,079 KB
£ Use advanced options for buk resize..) . ualr-ph-0018_na_na_p... 8/29/2019 10:23 AM TIF File 18,765 KB
Batch rename settings n
Name pattem Libraries
SN_aw v | | Options ‘ !
This PC
Network
File name: ‘ ~ |
Files of type: ‘Common Graphic Files > |
Outputt folder for resutt files: {or placeholders. like: $D) | Sort fles. ‘ | Add | | Remove ‘ | Tomm | | Load TXT |
|C:\Users\enﬂanner.UALR\Desktap\Examp\e\kccess\ ‘
Irput files:( §) | Add all | | Remove &l ‘ | Move down | |Save as TXT|

| Use cument (Look in) foider | | Browse

[include subfolders for "Add all" button; not remembered)

[#] Show Preview image

Run test rename Preview image

Cancel
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4. |In the Batch conversion window, under Work as: select Batch conversion - Rename result
files.

5. Under Batch conversion settings Output format select JPG - JPG/JPEG Format from the
dropdown menu.

6. Next to the dropdown menu click Options. In the Options dialog box, move the Save quality
slider all the way to the right under good and click OK.

JPEG/GIF save options n
JPEG
low 100 good
Save qualty: < >

[[] Save as progressive JPG

[[] Save a= grayscale JPG {please rememberl)

[] Disable chroma color subsampling (use 1x1 blocks)
Keep original EXIF data {f JPG to JPG)

Keep original IPTC data

Keep original JPG-Comment

Keep original XMP data

[ Try to save with original JPG quality (estimation)
Reset EXIF orientation tag

[ Set file size: |150.00 | kB (Kilobyte)

GIF:

[] Save intedacad

[[] Save with a transparent color
Use main window color for transparency
Choose transparent color during saving
Set transparency value to palette entry: 0

Profiles:

load || Deete || Save
7. Select the checkbox next to Use Advanced Options (for bulk resize...) and then click
Advanced.

8. Inthe Advanced dialog box, match the settings to the image below and click OK.

Set for all images: X
[Jcror: [CJCHANGE COLOR DEPTH:
Xpos: 0 Ypos: 0 {can be 16.7 Milion colors (24 BPF) [ Sharpen: (-9
Width: Height: negative) 256 Colors (8 BPP) [ Brightness: l:l (-255 - 255)
P Left top Right top 16 Colors (4 BPF) [ Contrast: [ |#27-12m
comer: Certer | Get cument sel. 2 Colors (black /white) (1 BPF) [[]Gamma comection: |:| (0,01 - 6.99)
Left bottom Right bottom Custom colors: |0 (2 - 256) [ Saturation l:l (-255 - 255)
RESIZE- Use Floyd-Steinberg dithering [JColer balance - R: l:l (-255 - 255)
(®) Set new size: Use best color quality (slower for large images) [IColor balance - G: |:| (-2b5 - 255)
() Set one or both sides ta:
Width: Height: [ Auto-adjust colors [C]Color balance - B: (-255 - 255)
@ pixels ] Horizontal fiip [ Biur fitter: 1 {1 - 99)
(®) Set long side to: Oem [ Vertical fip [ Median filter: 3 -9
(O Set short side to: Oinches [ Rotate left [] Fine rotation: l:l (-360.0 - 360.0)
() Set image size to: MegaPixel L] Retate right MISCELLANEOUS:
() Set new size as percentage of original: [ Convert to grayscale []Overwrite existing files
Width: . Height: E [ Negative [] Delete original files after conversion
Preserve aspect ratio (proportional) (] Auto-crop borders [[]Create subfolders in destination folder
lUse Resample function (better quality) [ Canvas size Settings [[]5ave files with criginal datetime
[] This is the minimal size (f both sides set) [ Add averay text Settings [] Apply changes to all pages (TIF/PDF saving)
[] Resize based only on new/old DP| value [ Add watermark image Settings [JCustom processing order | Chande arder
Dont enlarge smaller images Replace color B
[[]Dont shrink bigger images IH__(|35 t::: _ Load seffings SEEEETIE
Set new DP value: 72 [IReG [JBGR []BRG []GRB []GER TerEs

9. Under Batch rename settings, the name pattern should be $N_aw (for access/web files).

Batch rename settings:
Mame pattem:
| SN_aw e | Options
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10. Next, locate and open the folder containing the Preservation master files to be converted to
JPEG. Click the Add all button to add the files to the Input files queue.

FllE Name:

Files of type:

Add

Add all

11.Under Output folder for result files, Browse to the Access folder to save the JPEG files.
12.Finally, click Start Batch.

Moving Preservation, CONTENTdm, and Access/Web versions to
cahc_stage server - Photos and Documents

1. Onthe cahc_stage server (S:\ drive), find the folder titled Digitization.
2. Copy the entire folder directory from the computer desktop to the Digitization folder.

3. Once copying is complete, delete the folder from the computer desktop.

See Uploading to CONTENTdm instructions to complete the next steps.
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Digitizing Audio
Any special needs of the collection found during the selection process (e.g., whether special
equipment is necessary for digitization or accession numbers need to be assigned), should be

addressed before beginning the scanning process. The equipment to digitize audio recordings is
found in the cabinet located in the Digital Services Lab.

Naming - Audio
The file name will reflect the finding aid’s numbering system. How the file name will be constructed

depends upon whether audio recordings are grouped together in a collection or are dispersed
throughout a collection. The following is a guide to the terminology used in saving files:

Definitions

e ualr: Every file name will have ualr at the beginning to emphasize it belongs to UALR CAHC.
e ms or orh: ms is the abbreviation for manuscripts; orh is for the oral history collection.

e Record group/series/subseries numbers: A manuscript or photograph collection may be
divided into record group, series, or subseries. If this is the case, then include these numbers
number in the file name.

e Audio number: Use aud before the number. The number will be the same as the
identification number given to the original audio recording. Do not number audio recordings
based on the sequence in which it is copied.

e Version: Designate the audio version using one of the following abbreviations: pm =
preservation master, dm = CONTENTdm version, aw = access/web version, and ot = other

e File type: File names should end according to its format (e.g., “wav”)

Additional Notes:

e Use lower-case letters when naming files.
e Use underscores or dashes to represent spaces (e.g., ualr-0001_07 instead of ualr 0001 07).
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e Use naif afield in the file name does not apply

Naming templates

To name recordings that are grouped together and individually identified, use the following
template:

m ms or ph#_ RG# or Series#_ Series or Subseries# Aud#_

To name recordings that are dispersed throughout a collection, use the following template:

msorph#_ | RG#or Series or Box#  Folder#_  Aud#_
Series#_ Subseries#_

Naming Recordings in the Oral History Collection
For a recording from the Oral History Collection, the file name would be:

ualr- orh-0050_ |aud01_ pm. wav

ualr-orh-0050_aud01_pm.wav

Naming recordings grouped together and individually numbered

The following is an example of how to format a file name. For a preservation master copy belonging
to the Jim Guy Tucker Collection, in record group five, subseries one, reel number 1, this template
illustrates how the file name would be derived:

ms or ph#_ RG# or Series#_ Series or Subseries# Aud#_

ualr- ms-0004 09 01 aud0001 pm. wav

ualr-ms-0004_09_na_aud0001_pm.wav
Naming recordings dispersed throughout a collection

For a recording from the John Barker Papers, series 1, box 2, folder 6, the file name would be:

msorph#_ | RG#or Series or Box#  Folder#_  Aud#_

Series#_ Subseries#_

ualr- ms-0050_ 01_ na_ 02_ 06_ audo1_ pm. wav

ualr-ms-0050_01_na_02_06_aud01_pm.wav
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Capturing the Preservation Master - Audio
Reel-to-Reel

For audio on reel-to-reel, use the TEAC X-300R. The only dial that you may need to adjust is the output
dial if the volume is too low. It is usually set at 5, but may be turned up to 8 if needed.

1. Place the left plug in output 14 (R/R left) and the right output in output 13 (R/R Right)

2. Pull out the drawer that holds the tape machine and turn the key to lock the drawer in place.
3. Switch the main power to ON
4,

Load tape onto reels

Using the machine

1. Pull the drawer out and lock the shelf to keep the machine from pushing back into the
cabinet.

2. Place reel with tape onto the left spool and the empty reel on the right spool.
3. Turn the spool counter-clockwise to lock the reel into place.

4. Feed the tape into the machine. Follow this diagram to correctly load the tape.

Make sure the
________ : tape has enough
tension to pull the
knob up.
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5. Once the tape reaches the right side of the machine, feed the tape into the center

notch inside the reel. Make a small loop at the end of the tape to help latch it to the
reel.

6. Once the tape is threaded into the second reel, turn the reel two to three times to
secure the film.

7. Press the power button.

8. Make sure the “gain” dials above the cassette player are at equal settings:

OCUSTite

9. Plug the USB cable from the audio equipment cabinet into the computer.
10. Open Audacity on the computer. Set Audacity to the following specifications.

11. Leave the mic at the default volume

- +

¢ o

12.Next to the mic’s drop down menu, make sure “Focusrite USB” is selected
Focusrite USB (Focusrite USB Au v

13.Set the Project Rate to (Hz) to 96,000

Project Rate (Hz):
96000 -

14.Perform a test recording. Play and record the audio recording, listen using the
headphones directly plugged into Scarlett. Assess the quality for the following:

a. If the speakers are unintelligible because the recording is playing quickly,
adjust the speed by pushing the Speed button. If it does not improve sound
quality, contact the Multimedia Archivist.



b. Determine whether the reel-to-reel output dial is satisfactory at 5 or improves
when increased (do not go past 8).

c. Finally, stop recording. Unplug the headphones from Scarlett and plug the
headphones into the computer. Play the recording back. Does everything
sound normal? If not, please contact the Coordinator of Media.

d. Pay attention to the sound output in the visual histogram in Audacity. When
necessary, use the gain dials above the cassette player to adjust the sound.
You want the histogram to look similar to the screenshot on the following

page.

15.Erase the test recording by clicking the x in the top left corner and plug the headphones
into Scarlett.
16.Rewind to a point right before the audio begins.

17.Click the record button in Audacity and then hit play on the machine. Let it play until
you no longer hear audio. At that point, hit stop in Audacity and then stop on the
machine.

18.Save the recording, first exporting as a .wav file and then exporting as an .mp3 file
(which will automatically reduce it to 48,000 (Hz)).

€ Audacity

File Edit Select View Transport Tracks Generate Effect Analyze Tools Help

) L
New Ctrl+N 5 - 127 8
Open... Ctrl+0 7
: Qe XIOr
Recent Files >
Close Chrle W tocusrite USB (Focusrite USB Au w2 (Stereo)
i e 30 24 48 42 5 b
Save Project >N |
== S 20.0
Export > Export as MP3 o=
Import > Export as WAV
Page Setup... Export as 0GG
Print. Export Audio... Ctrl+Shift+E
Export S Audi
Exit Ctrl+Q Expore Labiels .
: Uy
32-bit float Export Multiple... Ctrl+Shift+L
1.
70_ Export MIDL... =
1.0
0.5
y L B S T R (O ([P
. ;
Network
File name: untitled wav v ‘ | Save |
Save as type: WAV (Microsoft) signed 16-bit PCM v Cancel

yrmat Options

19.If the reel is two-sided, under “Direction,” select the left button and record the other
side.

Cleaning the Teac X300R

1. Wet a chamois swab with rubbing alcohol and lightly clean the rubber rollers that come into
contact with the tape. These will be dirty, but do no rub them aggressively or you may rub off
excessive rubber from the rollers.
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Cassette Tapes

For audio on cassettes, use the Tascam 202 MK IV cassette deck.

1. Place theleft plug in output 16 (Cass Left) and the right output in output 15 (Cass Right).

2. Place the cassette in slot one with Side A facing to the front.

3. Keep Dolby Noise Reduction off, unless the cassette label indicates that Dolby B, or NR, was
used in the recording (labels will vary).
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4, Verify that the reverse mode is in the proper setting. The mode should only be in the “One
way mode”

You have a choice of three settings:

==:One way mode
Set the switch to this position to playback
only one side.

=: Two way mode
Set the switch to this position to play back
both sides of the tape in one session. When
playback reaches the end of side “A”", the
playback direction is automatically reversed,
and playback continues on side “B™.

C20: Repeat mode
Set the switch to this position. Both sides
of the tape are played back as many as 5
times.

4. Set the DOLBY NR switch.

DOLBY NR
on OFF
11

Set the switch to the ON position when playing
back tapes recorded with Dolby NR.

To play tapes recorded without Dolby NR, set the
switch to the OFF position

5. Press the PLAY (€ or P) key.

PLAY PLAY
- >

N\

Pressing the » key starts playback from side
wA”,

Pressing the <« key starts playback from side
“B

5. Plug the USB cable from the cabinet into the computer.

6. Make sure the “gain” dials above the cassette player are at equal settings.

OCUSTILE i

7. Open Audacity. Set Audacity to the following specifications

8. Leave the mic at the default volume

0 - +
W ittt
9. Next to the mic’s drop down menu, make sure “Focusrite USB” is selected
Focusrite USB (Focusrite USB Au v

10. Set the Project Rate to (Hz) to 96,000

Project Rate (Hz):
96000 -

11. Perform a test recording. Play and record the audio recording, listening using the



headphones directly plugged into the Scarlett. Assess the quality for the following:

a.

If the speakers are unintelligible because the recording is playing too quickly

or slowly, contact the Coordinator of Media.

b. Pay attention to the sound output in the visual histogram in Audacity. When
necessary, use the gain dials above the cassette player to adjust the sound. You
want the histogram to look similar to the screenshot on the following page.

c. Finally, stop recording. Unplug the headphones from Scarlett and plug
the headphones into the computer. Play the recording back. Does
everything sound normal? If not, please contact the Coordinator of

Media.

12.Erase the test recording by clicking the x in the top left corner and plug the headphones
into Scarlett.

13.Rewind to a point right before the audio begins.

14.Click the record button in Audacity and then hit play on the machine. Let it play until

you no longer hear audio. At that point, hit stop in Audacity and then stop on the
machine.

15.Save the recording, first exporting as a .wav file and then exporting as an .mp3 file
(which will automatically reduce it to 48,000 (Hz)).

File Edit Select View Transport Tracks

New
Open...
Recent Files

Close
Save Project

Export
Import

Page Setup...

Print...

Exit

Ctri+N
Ctrl+O

Ctrl+W

Ctrl+Q

4] ]

>

Generate Effect Analyze Tools

L
[Tzl 8]
Qe k| X

ine (Bluetooth AV, v | 2 (Stereo) Recor v ‘D Spe

15:00

> Export as MP3
> Export as WAV
Export as 0GG
Export Audio...
Export §
Exp

-1.0

1.0

Export MIDI...

Export Multiple...

Ctrl+Shift+E

ted Audio...

Ctrl+Shift+L

e
Network
Fie name: [unttied wav v] [ sae

Save as type: WAV (Microsoft) signed 16t PCM v Cancel

>rmat Options

16.If there is a Side B, press the backward play button (X) to record the other side (no need
to rewind or flip the tape first if you are at the end of Side A).
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LP Vinyl Records (33 or 45 RPM)
For audio on vinyl LP records, use the Rek-O-Cut Model CVS turntable.

1. Place the left plug in output 12 (Phono Left) and the right output in output 11 (Phono Right).

2. Pull out the drawer that holds the turntable and turn the key to lock the drawer in place.
3. Carefully lift the plastic cover off of the turntable.
4. Turn the power dial clockwise to turn on the turntable.

5. Select the correct speed for the vinyl record that you are digitizing. The speed is typically listed
30



on the record'’s label. 12" records are generally 33 RPM and 7” records are generally 45 RPM.
6. Handle records on the edges and avoid touching the grooves.
7. For 12" records, place the record on the turntable platter. Lock the record’s spindle hole with the

turntable spindle.
8. For 7" records, locate the aluminum adapter and place it on the turntable’s spindle. Place the

record on the turntable platter and lock it into the 7” adapter.
- ol

9. Plug the USB cable from the cabinet into the computer.

10. Make sure the “gain” dials above the cassette player are at equal settings:

11. Open Audacity. Set Audacity to the following specifications
12. Leave the mic at the default volume

. +
4 Q-
13.Next to the mic’s drop down menu, make sure “Focusrite USB” is selected
Focusrite USB (Focusrite USB Au v
14. Set the Project Rate to (Hz) to 96,000
Project Rate (Hz):
96000 -

15.Perform a test recording.
16.Press the start/stop button on the turntable. This will spin the record on the platter.
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17. Unlock the clip that holds the turntable arm down. Do not move the arm weight or anti-
skating dial.

18. Lift the cue lever completely up
19. Move the arm to the record by pushing on the metal headshell. Never touch the stylus.

20. Move the full arm so that the phono cartridge stylus is oriented directly above the record’s
lead-in grooves.

A A

21.Press record in Audacity
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22.Lower the cue lever completely and the stylus will begin to play the record grooves.

23, Listen using the headphones directly plugged into the computer. Assess the quality for the
following:

a. If the speakers are unintelligible because the recording is playing too quickly or
slowly, contact the Coordinator of Media.

b. Pay attention to the sound output in the visual histogram in Audacity. When
necessary, use the gain dials above the turntable player to adjust the sound. You
want the histogram to look similar to the screenshot on the following page.

c. Finally, stop recording. Unplug the headphones from Scarlett and plug the
headphones into the computer. Play the recording back. Does everything sound
normal? If not, please contact the Coordinator of Media.

24.When the recording has finished, press up on the cue lever to remove the stylus from the
record. Press the on/off button to stop the platter from spinning.
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24. Move the turntable arm back to the rest by using the headshell lever. Lower the cue lever when
the arm is above the arm rest. Lock the arm into the rest.

25. Place the dustcover back on the turntable and insert the dustcover’s hinges in the appropriate
slots in the turntable.

26. Turn the power dial counterclockwise to power off the turntable.

When putting in numbers for boxes,

Saving the Preservation Master - Audio folders, and documents, add
preceding Os based on the total

Click Export under the file menu. Export the audio recording number of boxes in a record

as a.wav file. group/series, folders in a box, and
audio recordings in a folder (e.g., box

Save the .wav file in the Collection# > Preservation folder 02) for a collection with over a

that you created on the desktop, hundred boxes versus box 20 for a

collection with 25 boxes total).
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Creating the CONTENTdm Version - Audio

From the preservation master, create the CONTENTdm version, which will be uploaded to
CONTENTdm. Open the preservation master in Audacity and export the file again, this time as an
mp3. It will automatically reduce the Project Rate (Hz) to 48,000.

Saving the CONTENTdm Version - Audio

1. See the instructions above on naming the file (the name will only differ from the
preservation master by using “dm” instead of “pm” for version and “mp3” instead of “wav”

for file type).
2. After you have named it, save it in the CONTENTdm folder.

3. Once you have both files ready, you will transfer the wav file and the mp3 file (not the
Audacity working files) to the cahc_stage server.

Moving Preservation and CONTENTdm versions to cahc_stage
server - Audio

1. Onthe cahc_stage server (S:\ drive), find the folder titled Digitization.
2. Copy the entire folder directory from the computer desktop to the Digitization folder.

3. Once copying is complete, delete the folder from the computer desktop.

See Uploading to CONTENTdm instructions to complete the next steps.
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Digitizing Video

Naming - Video

The file name will reflect the finding aid’s numbering system. How the file name will be

constructed depends upon whether audio recordings are grouped together in a collection or are
dispersed throughout a collection. The following is a guide to the terminology used in saving files:

Definitions

ualr: Every file name will have ualr at the beginning to emphasize it belongs to UALR
CAHC.

ms and orh: ms is the abbreviation for manuscripts; orh is for the oral history
collection.

Record group/series/subseries numbers: A manuscript or photograph collection
may be divided into record group, series, or subseries. If this is the case, then include
these numbers number in the file name.

Video number: Use vid before the number. The number will be the same as the
identification number given to the original audio recording. Do not number video
recordings based on the sequence in which it is copied.

Version: Designate the audio version using one of the following abbreviations: pm =

preservation master, dm = CONTENTdm version, aw = access/web version, and ot = other

File type: File names should end according to its format (e.g., “avi”)

Additional Notes:

Use lower-case letters when naming files.

Use underscores or dashes to represent spaces (e.g., ualr-0001_07 instead of ualr 0001 07).

Use na if a field in the file name does not apply

Naming templates

To name recordings that are grouped together and individually identified, use the following
template:

ms or ph#_ RG# or Series#_ Series or Subseries# Aud#_

To name recordings that are dispersed throughout a collection, use the following template:

ualr-
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msorph#_  RG#or Series or Box#_  Folder#_ Aud#_

Series#_ Subseries#_




Naming Recordings in the Oral History Collection
For a recording from the Oral History Collection, the file name would be:

ualr- orh-

ualr- orh-0050_ [vid01_ pm. avi

ualr-orh-0050_vid01_pm.avi

Naming recordings grouped together and individually numbered

The following is an example of how to format a file name. For a preservation master copy
belonging to the Jim Guy Tucker Collection, in record group five, subseries one, video number 1,
this template illustrates how the file name would be derived:

ms or ph#_ RG# or Series#__ Series or Subseries# vid#_

ualr- ms-0004 05 01 vid0001 pm. vid

ualr-ms-0001_05_01_vid0001_pm.avi
Naming recordings dispersed throughout a collection

For a video from the John Barker Papers, series 1, box 2, folder 6, the file name would be:

ualr- msorph#_  RG#or Series or Box#  Folder#_  vid#_

Series#_ Subseries#_

ualr- ms-0050_ 01_ na_ 02_ 06_ vid01_ pm. avi

ualr-ms-0050_02_06_vid01_pm.avi
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Digitizing Reel-to-Reel Film

Blackmagic Media Express

The digitization process will use the Blackmagic Intensity Shuttle hardware and Blackmagic Media
Express software. The Blackmagic Intensity Shuttle is the conduit between the EImo TRV-16G
projector and the computer used for digitization.

1. Connect the blue USB cable into the Intensity Shuttle adapter. The other end should be
connected to a USB port at the back of the computer.

—ww o

oM Our
B VIORG OAT  wBeT O

S$-VIDEO 1N VIDEO IN

2. Plug one end of the S-Video cable into the Out port on the projector, and the other end
into the In port on the AVT-8710 Time Base Corrector. This device helps to stabilize the image
from videotape before the image is digitized with the Blackmagic Intensity Shuttle. A second
S-Video cable should connect from the Time Base Corrector’'s OUTPUT port to the Intensity
Shuttle’s S-VIDEO IN port.

S-VIDEO

DCIN
SC-PH. SyE

DC IN
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3. Plugthered RCA cable into the Audio Out port on the projector, and the other end into the
AUDIO IN port on the Blackmagic Intensity Shuttle.

<l =N

4. Make sure the cableis plugged into the red port next to the white and yellow
ports, not the blue and green ports (these are only for component video)




5. Connect the power cord into the projector and surge protector.

7. Press the button on the side of the right arm to unlock it and pull the arm out.
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8. Assemble the projector by lifting up the arms that hold the tape.

9. Release the cover on the front of the projector to view the internal gears. This view will
help you see where to feed the film in the projector.

A

11.Next, place an empty reel on the left arm of the machine. This reel will receive the film as it is
fed through the projector on the other side.
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12. After the reels are locked and the cover is open, turn the reel on the right arm clockwise to
release the film and begin feeding it into the projector. Always give the film a little slack in
order to prevent it from tearing. When you need more film, turn the reel instead of pulling.

Pulling film manually out of the reel can damage the film.
WA RN :
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13.0nce the film is successfully fed into the projector, feed it up into the reel on the left arm.
Again, make sure you have an adequate amount of slack in order to feed it up. Once you
have enough slack, place the film into the notch inside of the reel. Turn the reel clockwise
two to three times in order for the film to stay secure in the reel.

14.Log onto the computer using the admin account (DSL supervisor can do this for you) and
launch Blackmagic Desktop Video Setup. Click the center icon under Intensity Shuttle
and verify S Video input is selected.

2] Blackmagic Desktop Video Setup. - o 52
Help

Desktop Video Setup

Intensity Shuttle

O

15.0pen Blackmagic Media Express and click on the tab Log and Capture.
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16.Click Preferences under the Edit menu. Make sure the preferences screen matches
this screenshot. Browse to the Collection# > Preservation folder you created on the
desktop as the save location. The .avi preservation master file will be auto-saved here
when Capture is stopped.

Make sure
the Log and
Capture tab
is selected

Project Video Format: | 525i59.94 NTSC -
Capture File Format: ;VI 8-bit YUV =y ‘\ Quality
[] use dropped frame timecode

. . Capture from an RGB source
This step is -
important because Capture from a YUV source
it determines how Capture two independent streams as 3D
the file will be Use absolute frame numbering when capturing DPX
saved.

trapturing DPX files, use |8 ¥ digit numbers in the frame count

Capture audio and video to: lc:\Users\admin\Documents |

Browse | For all video and audio media file captures

Capture still frames to: 1C:\Users\admin\Documents |
[7 E?@ ; For all still frame captures only

[] stop capture if dropped frames are detected

[] stop playback if dropped frames are detected

[] use Anamorphic SD 16:9

[] Continue playback when in the background

Set deck to |5 vj second pre-roll for cueing
When capturing use a 5 v'\ frame timecode offset
When mastering use a 6 v‘ frame timecode offset

17.Switch the main power to On. On the computer, click Capture in Blackmagic Media Express.
Immediately after clicking capture, turn the reel switch to the 5:00 position. The projector will

begin playing the film, and Blackmagic will begin digitizing.




# Untitled - Media Express

00:00:00:00

Dial must be turned to
5:00 position to begin
playback. This is two clicks
clockwise from the OFF
position.

18.Click capture a second time when the video has finished playing to stop the recording in
Blackmagic Media Express.
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Rewinding Film
1. Feed the film back into the notch of the original reel on the right arm of the projector.
2. Turn the reel two or three times to make sure the film is securely in place. Next,
turn the reel switch left to the 9:00 position.

3. When your film is rewound, move the dial to the center position to turn off the motor. This
will stop the reel from continuing to spin on the arm.
4. Then, place the cover back onto the projector, remove the reels, and collapse the arms

back into the projector.

46



Cleaning the 16mm projector

The Elmo TRV-16G projector usually requires cleaning after the playback of each film. Film
may be dirty and physically and/or chemically degraded.

1. After afilmis played back and rewound, spray the film path of the projector with a can
of compressed air.

2. Wet a chamois swab with rubbing alcohol and lightly clean the rubber rollers that
come into contact with film. These will be dirty, but do no rub them aggressively or
you may rub off excessive amounts of rubber from the rollers.
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Digitizing VHS Tapes
Blackmagic Media Express

The digitization process will use the Blackmagic Intensity Shuttle hardware and Blackmagic Media
Express software. The Blackmagic Intensity Shuttle is the conduit between the projector and the

computer used for digitization.

1. Connect the blue USB cable into the Intensity Shuttle adapter. The other end should be
connected to a USB port at the back of the computer.

2. Connect the S-Video cable and red and white RCA cables into the S-Video and Audio Out
ports on the back of the VCR.
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3. Connect the other end of the s-video cable into the In port on the AVT-8710 Time Base
Corrector. This device helps to stabilize the image from videotape before the image is
digitized with the Blackmagic Intensity Shuttle. A second S-Video cable should connect from
the Time Base Corrector's OUTPUT port to the Intensity Shuttle’s S-VIDEO IN port.

4. Connect the red and white RCA cables to the Audio In ports of the Blackmagic Intensity

Shuttle. Plug one end of the S-Video cable into the Out port on the projector, and the other
end into the In port on the AVT-8710 Time Base Corrector.

7 M

’ Blackmagic« e

0

3 %
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5. Log onto the computer using the admin account (DSL supervisor can do this for you) and
launch Blackmagic Desktop Video Setup. Click the center icon under Intensity Shuttle

and verify S Video input is selected.
[E] Blackmagic Desktop Video Setup = O X

Help

Desktop Video Setup

Intensity Shuttle

®

6. On the computer, launch Blackmagic Media Express. Click on the Log and Capture tab.

00:00:00:00




7. Click Preferences under the Edit menu. Make sure the preferences screen matches
this screenshot. Browse to the Collection# > Preservation folder you created on the

desktop as the save location. The .avi preservation master file will be auto-saved here
when Capture is stopped.

Project Video Format: | 525i59.94 NTSC v
Capture File Format: | AVI 8-bit YUV S Quality

[[] use dropped frame timecode

Capture from an RGB source
Capture m a YUV source
Capture two independent streams as 3C
Use absolute frame numbering when capturing DPX
When capturing DPX files, use |8 v.| digit numbers in the frame count
Capture audio and video to: !C:\Users\admin\Documents ‘ ] .
This step is
Browse For all video and audio media file captures important
. - because it
Capture still frames to: |C:\Users\admm\Documents l .
determines
Browse For all still frame captures only how the files
[] stop capture if dropped frames are detected will be saved

[] stop playback if dropped frames are detected
[[] use Anamorphic SD 16:9

[C] continue playback when in the background

Set deckto 5 v  second pre-roll for cueing
When capturing use a | 0 v | frame timecode offset
When mastering usea |0 v  frame timecode offset

0K Cancel

8. Power on the VCR.

9. Insert the VHS tape into the VCR and rewind if necessary.
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10.Press Stop on the VCR when the tape automatically begins playing.

11.Click Capture on Blackmagic Media Express, and immediately press Play on the
VCR. The tape will begin playing and Blackmagic will begin digitizing. -

Capture Clip Bateh

12.Click Capture a second time after the content on the tape has finished playing. This will
stop the recording in Blackmagic Media Express. If blank tape remains on the cassette, press
the stop button once on the VCR and press the rewind button.

13.Press eject to remove the videocassette from the VCR.

Cleaning a VCR after digitizing a VHS
1. Use a VHS cleaning tape after digitizing a VHS.
2. Periodically, the magnetic heads on a VCR may need extra cleaning.
3. Remove the top cover of the VCR
4. Use a chamois swab with rubbing alcohol to clean the tape path. This path includes
the heads, rubber roller, and capstan. Never use cotton g-tips on video tape heads.
The head is small and more fragile than heads used in audio tape recorders.
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Digitizing DVCAM and MiniDV

Blackmagic Media Express

The digitization process will use the Blackmagic Intensity Shuttle hardware and Blackmagic Media
Express software. The Blackmagic Intensity Shuttle is the conduit between the projector and the
computer used for digitization.

1. Connect the blue USB cable into the Intensity Shuttle adapter. The other end should be
connected to a USB port at the back of the computer.

2. Connect the S-Video cable and red and white RCA cables into the S-Video and Audio output
ports on the back of the DVCAM recorder
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3. On the other end of the cable, connect the s-video cable into the Time Base Converter and
the red and white RCA cables to the Audio In ports of the Blackmagic Intensity Shuttle.

T Z e

' Blackmagic e«

(088
8

4. Connect the power cord into the projector and surge protector.

5. Power on the Digital Videocassette Recorder and press the eject button to open the dust
cover.
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. Insert DVCAM cassette into the recorder. If digitizing a MiniDV cassette, insert into the

center of the tray. There are two metal guides in the tray for MiniDV cassettes.

. Rewind the cassette if needed by pressing “Rew” on the Digital Video Cassette Recorder.
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8. Log onto the computer using the admin account (DSL supervisor can do this for you) and
launch Blackmagic Desktop Video Setup. Click the center icon under Intensity Shuttle
and verify S Video input is selected

[E) Blackmagic Desktop Video Setup = m] X
Help

Desktop Video Setup

Intensity Shuttle

O

9. On the computer, launch Blackmagic Media Express. Click on the Log and Capture tab.

Epress - o x

00:00:00:00
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10.Click Preferences under the Edit menu. Make sure the preferences screen matches
this screenshot. Browse to the Collection# > Preservation folder you created on the
desktop as the save location. The .avi preservation master file will be auto-saved

here when Capture is stopped.

Project Video Format:  525i59.94 NTSC v

Capture File Format: | AVI 8-bit YUV v

[[] use dropped frame timecode

Capture from an RGB source

Capture from a YUV source

Capture two independent streams as 3D

Use absolute frame numbering when capturing DPX

When capturing DPX files, use '8 v, aigit numbers in the frame count

Quality

Capture audio and video to: lC:\Users\admin\Documents

Browse For all video and audio media file captures

Capture still frames to: IC:\Users\admin\Documents

Browse For all still frame captures only
[] stop capture if dropped frames are detected
[] stop playback if dropped frames are detected
[[] use Anamorphic SD 16:9

[C] continue playback when in the background

This step is
important
because it
determines
how the files
will be saved

Set deckto 5 v  second pre-roll for cueing
When capturing use a | 0 v | frame timecode offset
When masteringusea | 0 v | frame timecode offset

oK

Cancel

11.Click Capture on Blackmagic Media Express, and immediately press Play on the Digital
Videocassette Recorder. The tape will begin playing and Blackmagic will begin digitizing.

12.Click Capture a second time after the content on the tape has finished playing. This will
stop the recording in Blackmagic Media Express. If blank tape remains on the cassette,
press the stop button once on the Digital Videocassette Recorder and press the rewind
button.

13.Press eject to remove the cassette from the Digital Videocassette Recorder.



Digitizing Video8 and Hi8 Camcorder Tapes

Blackmagic Media Express

The digitization process will use the Blackmagic Intensity Shuttle hardware and Blackmagic Media
Express software. The Blackmagic Intensity Shuttle is the conduit between the projector and the

computer used for digitization.

14.Connect the blue USB cable into the Intensity Shuttle adapter. The other end should be
connected to a USB port at the back of the computer.

-

15. Attach the power adapter to the back of the camcorder and plug the adapter’s cable into
the power supply. Plug the power supply’s cable into a power strip.
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16.Connect the s-video cable and red and white RCA cables into the S VIDEO and AUDIO
ports on the side of the camcorder. Verify that the switch is on for OUTPUT.

-
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17.Connect the other end of the S-Video cable into the AVT-8710 Time Base Converter. This
device helps to stabilize the image from videotape before the image is digitized with the
Blackmagic Intensity Shuttle. A second S-Video cable should connect from the Time Base
Corrector's OUTPUT port to the Intensity Shuttle’s S-VIDEO IN port.

18.Connect the other end of the camcorder’s red and white RCA cables into the Audio In
ports of the Blackmagic Intensity Shuttle.
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20.With the top cover pushed up, the cassette tray mechanism is visible. Press the blue eject
button and the tray will pop out.




21.Insert the Video8 or Hi8 cassette into the tray. The cassette should be inserted upside
down as shown in the following photo.

22.With the cassette in place, gently push the tray forward until it clicks into place. The
camcorder will automatically load the tape.

23.Log onto the computer using the admin account (DSL supervisor can do this for you) and
launch Blackmagic Desktop Video Setup. Click the center icon under Intensity Shuttle and
verify S Video input is selected.

[E) Blackmagic Desktop Video Setup - o X
Help

Desktop Video Setup

Intensity Shuttle

O

62



63

24.0n the computer, launch Blackmagic Media Express. Make sure Log and Capture is
selected.

& Urtitied - Medis Express - o

00:00:00:00

25.Click Preferences under the Edit menu. Make sure the preferences screen matches
this screenshot. Browse to the Collection# > Preservation folder you created on the
desktop as the save location. The .avi preservation master file will be auto-saved
here when Capture is stopped.
Project Video Format: | 525i59.94 NTSC v
Capture File Format: | AVI 8-bit YUV v Quality

[[] use dropped frame timecode

wvhen capturing DPX files, use |8 This step is
Capture audio and video to: EC:\Users\admin\Documents Uit porta n,t
Browse For all video and audio media file captures :::::J;Tnts
Capture still frames to: [C:\Users\admin\Documents ‘ how the files
Browse | For all still frame captures only will be saved

[] stop capture if dropped frames are detected
[ stop playback if dropped frames are detected
[C] use Anamorphic SD 16:9

[] continue playback when in the background

Set deckto 5 v | second pre-roll for cueing
When capturinguse a 0 v  frame timecode offset
When masteringusea |0 v | frame timecode offset

OK Cancel



64

26.Locate the switch with the CAMERA, OFF, and VTR settings. The switch should be moved
to the VTR option.

FUVY L.
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27. Click Capture on Blackmagic Media Express, and immediately hit Play on the camcorder.
The tape will begin playing and Blackmagic will begin digitizing.

STOP © REW®—Pl AV
iy <@

DATA SCREEN
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28. Click Capture a second time after the content on the tape has finished playing. This will
stop the recording in Blackmagic MediaExpress. If blank tape remains on the cassette,
press the stop button once on the camcorder and press the rewind button.

29. Press the eject button when the tape has finished rewinding and remove the cassette.

Cleaning the Hi8 camcorder

1. After a tape is digitized, rewound, and removed, spray the film path of the camcorder
with a can of compressed air. Be careful not to tilt the can upside down.

2. Wet a chamois swab with rubbing alcohol and lightly clean the rubber rollers that
come into contact with film. These will be dirty, but do no rub them aggressively or
you may rub off excessive amounts of rubber from the rollers.

Saving the Preservation Master - Video

When putting in numbers for boxes,

In Blackmagic Media Express, the preservation master folders. and documents. add

.avifile is auto-saved and auto-named “Untitled” preceding Os based on the total
when you stop Capture. Locate the file in the number of boxes in a record
Collection# > Preservation folder on the desktop. Right group/series, folders in a box, and

. . . . audio recordings in a folder (e.g., box
click the file, select Rename, and rename file according

. . 02) for a collection with overa
to the file-naming standards above. hundred boxes versus box 20 for a

llecti ith25b total).
Proceed to create the CONTENTdm copy. cotectionw oxestotal
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Creating the CONTENTdm Version - Video
1. Open the HandBrake software.

2. Click Open Source. Navigate to the .avi preservation file.

% HondBrake

File Tools Presets Queue Help

_; i"ﬁ AddtoQueue ~ () StartEncode ﬁ Queue m Preview g Activity Log EEg Presets

Source:  Select ‘Source’ to continue
Title: Angle: Range: Chapters
Preset »
ns | Filters
Format: MP4
Web Optimized
 Align AV Start
iPod 5G Support
Tracks: No Tracks
Filters: No Filters
Size: No Source

3. Click browse to select the Collection# > CONTENTdm folder where the CONTENTdm
version will be saved.

4. Under Format, make sure MP4 is selected.

% HandBrake

File Tools Presets Queue Help
B opensource | () Adotocuene ~

Source:  Mountain View Gitaway 1975 108-885 720x45:

1 Audio Tracks, 0 Subts

itle
Tite: | 1(00:22:03) <] Angie [1 ~ | Range: | Chapters v |1 = - [E v | Duration: 00:29:03

e [Pt 08073 o 7] o] [Sovenewprot

Summary | Dimensions

Filters | Video | Audio | Subtities | Chapters
Format: NP4

) Align AWV Start
[] iPod 5G Support
Tracks: H.264 (x264), 30 FPS PFR
AAC (avcoded) Stereo
Foreign Audio Scan, Bured
Chapter Markers

Filters: Decomb

Size: 6341482 storage, 634x482 display




5. Click the Video tab. Make sure the video options match this screenshot.

Title: 1 (00:00:00) v | Angle: 1 v | Range: Chapters v 1 ol - | ¥ | Duration: 00:00:00

Presets: | Production Standard 4 l [ Reload H Save New Preset

Summary = Dimensions FilterAudio Subtitles | Chapters
Video Quality
e Constant Quality: 10 RF

Video Codec: H.264 (x264) v

Framerate (FPS): Same as source v
(@ Constant Framerate | Lower Quality Placebo Quality |
() Variable Framerate () Avg Bitrate (kbps):

/' 2-Pass Encoding Turbo first pass

Optimise Video:

Encoder Preset: Fast

Encoder Tune: | None v | [[] Fast Decode

Encoder Profile: | High v Encoder Level Auto v

6. Click the Audio tab. Make sure the audio options match this screenshot.

Summary = Dimensions | Filters VideSubtitIes Chapters

Audio Tracks
| Add Track - | | Clear | Selection Behavior | | Reload |
EE  1Unknown [pcm_s2 v | Codec AAC (avcodeq) v | Bitrate: v 192 | Mixdown | Stereo - B ®
Samplerate  Auto “  DRC |0 EG&TI‘I i E' Track Name

7. After your settings are properly configured, click Start to begin convert the .avi file to a
.mp4 file.

Saving the CONTENTdm Version - Video

1. See the instructions above on naming the file (the name will only differ from the
preservation master by using “dm” instead of “pm” for version and “mp4” instead of “avi”
for file type).

2. After you have named it, save it in the CONTENTdm folder.

3. Once you have both files ready, you will transfer the avi and mp4 files to the cahc_stage
server.

Moving Preservation and CONTENTdm versions to cahc_stage
server - Video

1. Onthe cahc_stage server (S:\ drive), find the folder titled Digitization.
2. Copy the entire folder directory from the computer desktop to the Digitization folder.

3. Once copying is complete, delete the folder from the computer desktop.

See Uploading to CONTENTdm instructions to complete the next steps.
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Uploading to CONTENTdm

Getting started

To add digital objects to CONTENTdm, you will need to work with CONTENTdm Project Client. If
this is your first time working in Project Client, you will need to create a log-in account in World
Cat. Contact the Director of Digital Projects and Initiatives with your World Cat log-in information
for access to Project Client.

1. Onceyou'rein the Project Client, click New in the Project menu. Enter your log-in. The
Server URL is: https://server15728.contentdm.oclc.org/

2. Inthe next screen, choose the appropriate collection you want to import. Collection names
are based off of media types. This will serve as a workspace for adding metadata to digital
photographs. Alternatively, you can also work in an Excel Spreadsheet to upload metadata.
Please contact the Multimedia Archivist with instructions on how to do so.

Uploading to CONTENTdm If:m'. i T

Open t.he CQNTENTdm Project Client and select the G Add Multiple Items
appropriate project.

| Add Compound Objects

For asingle item L. Edit Existing ltems

1.Under Common Tasks, click Add Item.

2. Under Specify the file, click Browse next to the File Name field. Find the CONTENTdm
derivative copy. Click Open.

3. Click Add at the bottom of the Add Item box. The image should appear on the Project

Spreadsheet.
For multiple items
1. Place all items into a single folder.
Common Tasks
2. In the Project Client, under Common Tasks, click Add i Add Item

Multiple Items. -
[E] Add Multiple [tems

3. Click Import from a Directory.

4, Click Browse and select the folder with the CONTENTdm
derivative copies.

5. Click Open.
6. Click Next at the bottom.

&) Add Compound Chjects
[ Edit Existing Items

7.In the next screen, click Add Items. The uploaded files should appear on the Project
Spreadsheet.
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For compound items

Common Tasks
1. Place the compound object into a single folder. “n| Add Itern
2. In the Project Client, under Common Tasks, click Add || Add Multiple Items
Compound Objects. [ Add Compound COlbjects

3. Inthe Add Multiple Compound Objects screen, click Add [ Edit Existing Items
next to Compound Object Wizard.

a. For photographs with two sides, click Document.

b. For documents with multiple pages, click Document.

¢. Foraudio recordings with multiple parts, click Document.

d. For video recordings with multiple files, click Document.
4. In the next screen, select the folder in which you saved the compound object. Click Next.
5. Under Page Information, click Label pages using sequence and.

a. For photographs, change Page to Side

b. For documents, keep Page

¢. Foraudio and video, change Page to Part

6. In the next screen, Click Finish.

Adding metadata to CONTENTdm

Please see the “UALR CAHC Photographs Metadata” spreadsheet, the “UALR CAHC Documents
Metadata” spreadsheet, the “UALR CAHC Audio Metadata” spreadsheet, or the “UALR CAHC
Video Metadata” spreadsheet available in the Google Drive CAHC Student Assistants >
Documents folder for further instructions on filling out the metadata fields. Once the metadata is
complete, saveitin the project folder Collection# > Documents and upload it to cahc_stage >
Digitization for approval.

Watermark metadata template for Photographs

All photographs use the gray UALR bar as a watermark. To add the bar, select Edit Metadata
Template, and then selectImages & Thumbnails on the sidebar. Under “Image Rights,” select
name “ualr” with the type “band.” Close out of this menu.
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